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Bio-Formats is a standalone Java library for reading and writing microscopy file formats, written by the Open Mi-
croscopy Environment consortium. It is capable of parsing both pixels and metadata for more than 120 file formats, as
well as writing to several formats. It also includes standardized metadata conversion to OME-XML and OME-TIFF.

Full details, including the very impressive list of supported file formats, are available at the LOCI website.

The primary goal of Bio-Formats is to facilitate the exchange of microscopy data between both different software
packages and different organizations, by converting proprietary microscopy data into the OME data model standard.
See our recent article on biological image formats and the Bio-Formats statement of purpose for more information.

Bio-Formats is released under the GNU General Public License (GPL); commercial licenses are available from Glen-
coe Software.

For general information about Bio-Formats and its features, please see http://loci.wisc.edu/software/bio-formats/. A
list of supported file formats is available at http://loci.wisc.edu/bio-formats/formats. A list of applications that use
Bio-Formats is available at http://loci.wisc.edu/bio-formats/applications.
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CHAPTER

ONE

INSTALLATION

Installation is usually as simple as downloading one of the files from http://loci.wisc.edu/bio-formats/downloads:

• either the complete Bio-Formats bundle with supporting libraries is available as loci_tools.jar, or

• the Bio-Formats standalone library is available as bio-formats.jar

and placing it in an appropriate directory. Specific installation instructions depend upon the application you are using;
please see the page for your application, as listed at http://loci.wisc.edu/bio-formats/applications.

See the Bio-Formats Download page for the most up-to-date version of Bio-Formats including daily and trunk builds
and source code repository information.
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CHAPTER

TWO

USER DOCUMENTATION

For information about what extensions to choose to import files, see

2.1 Dataset Structure Table

This table shows the extension of the file that you should choose if you want to open/import a dataset in a particular
format.

Format name File to choose Structure of files
AIM .aim Single file
ARF .arf Single file
Adobe Photoshop .psd Single file
Adobe Photoshop TIFF .tif, .tiff Single file
Alicona AL3D .al3d Single file
Amersham Biosciences
GEL

.gel Single file

Amira .am, .amiramesh,
.grey, .hx, .labels

Single file

Analyze 7.5 .img, .hdr One .img file and one similarly-named .hdr file
Andor SIF .sif Single file
Animated PNG .png Single file
Aperio SVS .svs Single file
Audio Video Interleave .avi Single file
BD Pathway .exp, .tif Multiple files (.exp, .dye, .ltp, ...) plus one or more direc-

tories containing .tif and .bmp files
Bio-Rad GEL .1sc Single file
Bio-Rad PIC .pic, .xml, .raw One or more .pic files and an optional lse.xml file
Bitplane Imaris .ims Single file
Bitplane Imaris 3 (TIFF) .ims Single file
Bitplane Imaris 5.5 (HDF) .ims Single file
Bruker (no extension) One ‘fid’ and one ‘acqp’ plus several other metadata files

and a ‘pdata’ directory
Burleigh .img Single file
Canon RAW .cr2, .crw, .jpg, .thm,

.wav
Single file

CellSens VSI .vsi, .ets One .vsi file and an optional directory with a similar name
that contains at least one subdirectory with .ets files

Continued on next page
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Table 2.1 – continued from previous page
Format name File to choose Structure of files

CellWorx .pnl, .htd, .log One .htd file plus one or more .pnl or .tif files and option-
ally one or more .log files

Cellomics C01 .c01, .dib One or more .c01 files
Compix Simple-PCI .cxd Single file
DICOM .dic, .dcm, .dicom,

.jp2, .j2ki, .j2kr, .raw,

.ima

One or more .dcm or .dicom files

DNG .cr2, .crw, .jpg, .thm,
.wav, .tif, .tiff

Single file

Deltavision .dv, .r3d, .r3d_d3d,
.dv.log, .r3d.log

One .dv, .r3d, or .d3d file and up to two optional .log files

ECAT7 .v Single file
Encapsulated PostScript .eps, .epsi, .ps Single file
Evotec Flex .flex, .mea, .res One directory containing one or more .flex files, and an

optional directory containing an .mea and .res file. The
.mea and .res files may also be in the same directory as
the .flex file(s).

FEI TIFF .tif, .tiff Single file
FEI/Philips .img Single file
Flexible Image Transport
System

.fits, .fts Single file

Fuji LAS 3000 .img, .inf Single file
Gatan DM2 .dm2 Single file
Gatan Digital Micrograph .dm3 Single file
Graphics Interchange For-
mat

.gif Single file

Hamamatsu Aquacosmos .naf Single file
Hamamatsu HIS .his Single file
Hamamatsu NDPI .ndpi Single file
Hamamatsu NDPIS .ndpis One .ndpis file and at least one .ndpi file
Hamamatsu VMS .vms One .vms file plus several .jpg files
Hitachi .txt One .txt file plus one similarly-named .tif, .bmp, or .jpg

file
IMAGIC .hed One .hed file plus one similarly-named .img file
IMOD .mod Single file
INR .inr Single file
IPLab .ipl Single file
IVision .ipm Single file
Imacon .fff Single file
Image Cytometry Standard .ics, .ids One .ics and possibly one .ids with a similar name
Image-Pro Sequence .seq Single file
Image-Pro Workspace .ipw Single file
Improvision TIFF .tif, .tiff Single file
InCell 1000/2000 .xdce, .xml, .tiff, .tif,

.xlog, .im
One .xdce file with at least one .tif/.tiff or .im file

InCell 3000 .frm Single file
JEOL .dat, .img, .par A single .dat file or an .img file with a similarly-named

.par file
JPEG .jpg, .jpeg, .jpe Single file

Continued on next page
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Table 2.1 – continued from previous page
Format name File to choose Structure of files

JPEG-2000 .jp2, .j2k, .jpf Single file
JPK Instruments .jpk Single file
JPX .jpx Single file
Khoros XV .xv Single file
Kodak Molecular Imaging .bip Single file
LEO .sxm, .tif, .tiff Single file
LI-FLIM .fli Single file
Laboratory Imaging .lim Single file
Leica .lei, .tif, .tiff, .raw One .lei file with at least one .tif/.tiff file and an optional

.txt file
Leica Image File Format .lif Single file
Leica SCN .scn Single file
Leica TCS TIFF .tif, .tiff, .xml Single file
Li-Cor L2D .l2d, .scn, .tif One .l2d file with one or more directories containing

.tif/.tiff files
MIAS .tif, .tiff, .txt One directory per plate containing one directory per well,

each with one or more .tif/.tiff files
MINC MRI .mnc Single file
Medical Research Council .mrc, .st, .ali, .map,

.rec
Single file

Metamorph STK .stk, .nd, .tif, .tiff One or more .stk or .tif/.tiff files plus an optional .nd file
Metamorph TIFF .tif, .tiff One or more .tif/.tiff files
Micro-Manager .tif, .tiff, .txt, .xml A ‘metadata.txt’ file plus or or more .tif files
Minolta MRW .mrw Single file
Molecular Imaging .stp Single file
Multiple Network Graphics .mng Single file
NIfTI .nii, .img, .hdr A single .nii file or one .img file and a similarly-named

.hdr file
NOAA-HRD Gridded Data
Format

(no extension) Single file

NRRD .nrrd, .nhdr A single .nrrd file or one .nhdr file and one other file con-
taining the pixels

Nikon Elements TIFF .tif, .tiff Single file
Nikon ND2 .nd2 Single file
Nikon NEF .nef, .tif, .tiff Single file
Nikon TIFF .tif, .tiff Single file
OME-TIFF .ome.tif, .ome.tiff One or more .ome.tiff files
OME-XML .ome Single file
Olympus APL .apl, .tnb, .mtb, .tif One .apl file, one .mtb file, one .tnb file, and a directory

containing one or more .tif files
Olympus FV1000 .oib, .oif, .pty, .lut Single .oib file or one .oif file and a similarly-named di-

rectory containing .tif/.tiff files
Olympus Fluoview/ABD
TIFF

.tif, .tiff One or more .tif/.tiff files, and an optional .txt file

Olympus SIS TIFF .tif, .tiff Single file
Olympus ScanR .dat, .xml, .tif One .xml file, one ‘data’ directory containing .tif/.tiff

files, and optionally two .dat files
Olympus Slidebook .sld, .spl Single file
Openlab LIFF .liff Single file

Continued on next page
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Table 2.1 – continued from previous page
Format name File to choose Structure of files

Openlab RAW .raw Single file
Oxford Instruments .top Single file
PCX .pcx Single file
PICT .pict, .pct Single file
POV-Ray .df3 Single file
Perkin Elmer Densitometer .hdr, .img One .hdr file and a similarly-named .img file
PerkinElmer .ano, .cfg, .csv, .htm,

.rec, .tim, .zpo, .tif
One .htm file, several other metadata files (.tim, .ano, .csv,
...) and either .tif files or .2, .3, .4, etc. files

PerkinElmer Operetta .tif, .tiff, .xml Directory with XML file and one .tif/.tiff file per plane
Portable Gray Map .pgm Single file
Prairie TIFF .tif, .tiff, .cfg, .xml One .xml file, one .cfg file, and one or more .tif/.tiff files
Pyramid TIFF .tif, .tiff Single file
Quesant AFM .afm Single file
QuickTime .mov Single file
RHK Technologies .sm2, .sm3 Single file
SBIG (no extension) Single file
SM Camera (no extension) Single file
SPCImage Data .sdt Single file
SPIDER .spi Single file
Seiko .xqd, .xqf Single file
SimplePCI TIFF .tif, .tiff Single file
Simulated data .fake Single file
Tagged Image File Format .tif, .tiff, .tf2, .tf8, .btf Single file
Text .txt, .csv Single file
TillVision .vws, .pst, .inf One .vws file and possibly one similarly-named directory
TopoMetrix .tfr, .ffr, .zfr, .zfp, .2fl Single file
Trestle .tif One .tif file plus several other similarly-named files (e.g.

.FocalPlane-, .sld, .slx, .ROI)
Truevision Targa .tga Single file
UBM .pr3 Single file
Unisoku STM .hdr, .dat One .HDR file plus one similarly-named .DAT file
VG SAM .dti Single file
Varian FDF .fdf Single file
Visitech XYS .xys, .html One .html file plus one or more .xys files
Volocity Library .mvd2, .aisf, .aiix,

.dat, .atsf
One .mvd2 file plus a ‘Data’ directory

Volocity Library Clipping .acff Single file
WA Technology TOP .wat Single file
Windows Bitmap .bmp Single file
Zeiss AxioVision TIFF .tif, .xml Single file
Zeiss CZI .czi Single file
Zeiss Laser-Scanning Mi-
croscopy

.lsm, .mdb One or more .lsm files; if multiple .lsm files are present,
an .mdb file should also be present

Zeiss Vision Image (ZVI) .zvi Single file
Zip .zip Single file

2.1.1 Flex Support

OMERO.importer supports importing analyzed Flex files from an Opera system.
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Basic configuration is done via the importer.ini. Once the user has run the Importer once, this file will be in the
following location:

• C:\Documents and Settings\<username>\omero\importer.ini

The user will need to modify or add the [FlexReaderServerMaps] section of the INI file as follows:
...
[FlexReaderServerMaps]
CIA-1 = \\\\hostname1\\mount;\\\\archivehost1\\mount
CIA-2 = \\\\hostname2\\mount;\\\\archivehost2\\mount

where the key of the INI file line is the value of the “Host” tag in the .mea measurement XML file (here: <Host
name="CIA-1">) and the value is a semicolon-separated list of escaped UNC path names to the Opera workstations
where the Flex files reside.

Once this resolution has been encoded in the configuration file and you have restarted the importer, you will be able
to select the .mea measurement XML file from the Importer user interface as the import target.

2.1. Dataset Structure Table 9
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CHAPTER

THREE

DEVELOPER DOCUMENTATION

3.1 Testing individual commits (internal developers)

At the bottom of many commit messages in https://github.com/openmicroscopy/bioformats, you will find a few lines
similar to this:

To test, please run:

ant -Dtestng.directory=$DATA/metamorph test-automated

This shows the command(s) necessary to run automated tests against the files likely to be affected by that commit. If
you want to run these tests, you will need to do the following:

Clone bioformats.git and checkout the appropriate branch (by following the directions on the Git usage page). Run
this command to build all of the JAR files:

$ ant clean jars

Switch to the test-suite component:

$ cd components/test-suite

Run the tests, where $DATA is the path to the full data repository:

$ ant -Dtestng.directory=$DATA/metamorph test-automated

By default, 512 MB of memory are allocated to the JVM. You can increase this by adding the ‘-
Dtestng.memory=XXXm’ option. You should now see output similar to this:

Buildfile: build.xml

init-title:
[echo] ----------=========== loci-testing-framework ===========----------

init-timestamp:

init-version:

init-manifest-cp:

init:

copy-source:

compile:

11
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test-automated:
[testng] [Parser] Running:
[testng] LOCI software test suite
[testng]
[testng] Scanning for files...
[testng] Building list of tests...
[testng] Ready to test 490 files
[testng] ........................................

and then eventually:

[testng] ===============================================
[testng] LOCI software test suite
[testng] Total tests run: 19110, Failures: 0, Skips: 0
[testng] ===============================================
[testng]

BUILD SUCCESSFUL
Total time: 16 minutes 42 seconds

Each of the dots represents a single passed test; a ‘-‘ is a skipped test, and an ‘F’ is a failed test. This is mostly just
for your amusement if you happen to be staring at the console while the tests run, as a more detailed report is logged
to loci-software-test-$DATE.log (where “$DATE” is the date on which the tests started in “yyyy-MM-dd_hh-mm-ss”
format).

If Ant reports that the build was successful, then there is nothing that you need to do. Otherwise, it is helpful if you
can provide the command, branch name, number of failures at the bottom of the Ant output, and the loci-software-
test-*.log file.

3.2 Exporting files using Bio-Formats

This guide pertains to version 4.2 and later.

3.2.1 Basic conversion

The first thing we need to do is set up a reader:

// create a reader that will automatically handle any supported format
IFormatReader reader = new ImageReader();
// tell the reader where to store the metadata from the dataset
reader.setMetadataStore(MetadataTools.createOMEXMLMetadata());
// initialize the dataset
reader.setId("/path/to/file");

Now, we set up our writer:

// create a writer that will automatically handle any supported output format
IFormatWriter writer = new ImageWriter();
// give the writer a MetadataRetrieve object, which encapsulates all of the
// dimension information for the dataset (among many other things)
writer.setMetadataRetrieve(MetadataTools.asRetrieve(reader.getMetadataStore()));
// initialize the writer
writer.setId("/path/to/output/file");

Note that the extension of the file name passed to ‘writer.setId(...)’ determines the file format of the exported file.

12 Chapter 3. Developer Documentation



Bio-Formats Documentation, Release 4.4.4

Now that everything is set up, we can start writing planes:

for (int series=0; series<reader.getSeriesCount(); series++) {
reader.setSeries(series);
writer.setSeries(series);

for (int image=0; image<reader.getImageCount(); image++) {
writer.saveBytes(image, reader.openBytes(image));

}
}

Finally, make sure to close both the reader and the writer. Failure to do so can cause:

• file handle leaks

• memory leaks

• truncated output files

Fortunately, closing the files is very easy:

reader.close();
writer.close();

3.2.2 Converting large images

The flaw in the previous example is that it requires an image plane to be fully read into memory before it can be saved.
In many cases this is fine, but if you are working with very large images (especially > 4 GB) this is problematic.
The solution is to break each image plane into a set of reasonably-sized tiles and save each tile separately - thus
substantially reducing the amount of memory required for conversion.

For now, we’ll assume that your tile size is 1024 x 1024, though in practice you will likely want to adjust this.
Assuming you have an IFormatReader and IFormatWriter set up as in the previous example, let’s start writing planes:

int tileWidth = 1024;
int tileHeight = 1024;

for (int series=0; series<reader.getSeriesCount(); series++) {
reader.setSeries(series);
writer.setSeries(series);

// determine how many tiles are in each image plane
// for simplicity, we’ll assume that the image width and height are
// multiples of 1024

int tileRows = reader.getSizeY() / tileHeight;
int tileColumns = reader.getSizeX() / tileWidth;

for (int image=0; image<reader.getImageCount(); image++) {
for (int row=0; row<tileRows; row++) {

for (int col=0; col<tileColumns; col++) {
// open a tile - in addition to the image index, we need to specify
// the (x, y) coordinate of the upper left corner of the tile,
// along with the width and height of the tile

int xCoordinate = col * tileWidth;
int yCoordinate = row * tileHeight;
byte[] tile =
reader.openBytes(image, xCoordinate, yCoordinate, tileWidth, tileHeight);

3.2. Exporting files using Bio-Formats 13
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writer.saveBytes(
image, tile, xCoordinate, yCoordinate, tileWidth, tileHeight);

}
}

}
}

As noted, the example assumes that the width and height of the image are multiples of the tile dimensions. Be careful,
as this is not always the case; the last column and/or row may be smaller than preceding columns/rows. An exception
will be thrown if you attempt to read or write a tile that is not completely contained by the original image plane. Most
writers perform best if the tile width is equal to the image width, although specifying any valid width should work.

As before, you need to close the reader and writer.

3.2.3 Converting to multiple files

The recommended method of converting to multiple files is to use a single IFormatWriter, like so:

// you should have set up a reader as in the first example
ImageWriter writer = new ImageWriter();
writer.setMetadataRetrieve(MetadataTools.asRetrieve(reader.getMetadataStore()));
// replace this with your own filename definitions
// in this example, we’re going to write half of the planes to one file
// and half of the planes to another file
String[] outputFiles =

new String[] {"/path/to/file/1.tiff", "/path/to/file/2.tiff"};
writer.setId(outputFiles[0]);

int planesPerFile = reader.getImageCount() / outputFiles.length;
for (int file=0; file<outputFiles.length; file++) {

writer.changeOutputFile(outputFiles[file]);
for (int image=0; image<planesPerFile; image++) {
int index = file * planesPerFile + image;
writer.saveBytes(image, reader.openBytes(index));

}
}

reader.close();
writer.close();

The advantage here is that the relationship between the files is preserved when converting to formats that support
multi-file datasets internally (namely OME-TIFF). If you are only converting to graphics formats (e.g. JPEG, AVI,
MOV), then you could also use a separate IFormatWriter for each file, like this:

// again, you should have set up a reader already
String[] outputFiles = new String[] {"/path/to/file/1.avi", "/path/to/file/2.avi"};
int planesPerFile = reader.getImageCount() / outputFiles.length;
for (int file=0; file<outputFiles.length; file++) {

ImageWriter writer = new ImageWriter();
writer.setMetadataRetrieve(MetadataTools.asRetrieve(reader.getMetadataStore()));
writer.setId(outputFiles[file]);
for (int image=0; image<planesPerFile; image++) {
int index = file * planesPerFile + image;
writer.saveBytes(image, reader.openBytes(index));

}
writer.close();

}
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3.2.4 Known issues

• #4128 (AVI writer does not support saving tiles)

• #4129 (APNG writer does not support saving tiles)

• #4130 (Java writer does not support saving tiles)

• #4131 (JPEG-2000 writer does not support saving tiles)

• #4132 (JPEG writer does not support saving tiles)

• #4133 (OME-XML writer does not support saving tiles)

3.3 Using Bio-Formats in Matlab

This section assumes that you have installed the bfopen.m script and loci_tools.jar, as instructed here.

The first thing to do is initialize a file:

data = bfopen(’/path/to/data/file’);

‘data’ is an array whose structure is a bit complicated. It is an n-by-4 array, where n is the number of series in the
dataset:

• The {s, 1} element (if s is the series index between 1 and n) is an m-by-2 array, where m is the number of planes
in the series:

– The {s, 1, t, 1} element (where t is the image index between 1 and m) contains the pixel data for the t-th
image in the s-th series.

– The {s, 1, t, 2} element contains the label for said image.

• The {s, 2} element of ‘data’ contains original metadata key/value pairs that apply to the s-th series.

• The {s, 3} element of ‘data’ contains color lookup tables for each image in the series.

• The {s, 4} element of ‘data’ contains a standardized OME metadata structure, which is the same regardless of
the input file format, and contains common metadata values such as physical pixel sizes—see “Accessing OME
metadata” below for examples.

3.3.1 Accessing planes

Here is an example of how to unwrap specific image planes for easy access:

data = bfopen(’/path/to/data/file’);
seriesCount = size(data, 1);
series1 = data{1, 1};
series2 = data{2, 1};
series3 = data{3, 1};
metadataList = data{1, 2};
% ...etc.
series1_planeCount = size(series1, 1);
series1_plane1 = series1{1, 1};
series1_label1 = series1{1, 2};
series1_plane2 = series1{2, 1};
series1_label2 = series1{2, 2};
series1_plane3 = series1{3, 1};

3.3. Using Bio-Formats in Matlab 15
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series1_label3 = series1{3, 2};
% ...etc.

3.3.2 Displaying images

If you want to display one of the images, you can do so as follows:

data = bfopen(’/path/to/data/file’);
% plot the 1st series’s 1st image plane in a new figure
series1 = data{1, 1};
series1_plane1 = series1{1, 1};
series1_label1 = series1{1, 2};
series1_colorMaps = data{1, 3};
figure(’Name’, series1_label1);
if (isempty(series1_colorMaps{1}))

colorMap(gray);
else

colorMap(series1_colorMaps{1});
end
imagesc(series1_plane1);

This will display the first image of the first series with its associated color map (if present). If you would prefer not to
apply the color maps associated with each image, simply comment out the calls to ‘colorMap’.

Using the image processing toolbox

If you have the image processing toolbox, you could instead use:

imshow(series1_plane1, []);

Displaying an animation

Here is an example that animates as a movie (assumes 8-bit unsigned data):

v = linspace(0, 1, 256)’;
cmap = [v v v];
for p = 1:series1_numPlanes

M(p) = im2frame(uint8(series1{p, 1}), cmap);
end
movie(M);

3.3.3 Retrieving metadata

There are two kinds of metadata:

• Original metadata is a set of key/value pairs specific to the input format of the data. It is stored in the [s, 2]
element of the data structure returned by bfopen.

• OME metadata is a standardized metadata structure, which is the same regardless of input file format. It is
stored in the [s, 4] element of the data structure returned by bfopen, and contains common metadata values such
as physical pixel sizes, instrument settings, and much more. See the OME Models & Formats pages for full
details.

16 Chapter 3. Developer Documentation
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Accessing original metadata

To retrieve the metadata value for specific keys:

data = bfopen(’/path/to/data/file’);
% Query some metadata fields (keys are format-dependent)
metadata = data{1, 2};
subject = metadata.get(’Subject’);
title = metadata.get(’Title’);

To print out all of the metadata key/value pairs for the first series:

data = bfopen(’/path/to/data/file’);
metadata = data{1, 2};
metadataKeys = metadata.keySet().iterator();
for i=1:metadata.size()

key = metadataKeys.nextElement();
value = metadata.get(key);
fprintf(’%s = %s\n’, key, value)

end

Accessing OME metadata

Conversion of metadata to the OME standard is one of Bio-Formats’s primary features. The OME metadata is always
stored the same way, regardless of input file format.

To access physical voxel and stack sizes of the data:

data = bfopen(’/path/to/data/file’);
omeMeta = data{1, 4};
stackSizeX = omeMeta.getPixelsSizeX(0).getValue(); % image width, pixels
stackSizeY = omeMeta.getPixelsSizeY(0).getValue(); % image height, pixels
stackSizeZ = omeMeta.getPixelsSizeZ(0).getValue(); % number of Z slices
voxelSizeX = omeMeta.getPixelsPhysicalSizeX(0).getValue(); % in µm
voxelSizeY = omeMeta.getPixelsPhysicalSizeY(0).getValue(); % in µm
voxelSizeZ = omeMeta.getPixelsPhysicalSizeZ(0).getValue(); % in µm

3.3.4 Saving files

First, make sure that you have loci_tools.jar installed in your MATLAB work folder.

Now, here is the basic code for saving planes (2 channels x 2 timepoints) to a file:

javaaddpath(fullfile(fileparts(mfilename(’fullpath’)), ’loci_tools.jar’));
writer = loci.formats.ImageWriter();
metadata = loci.formats.MetadataTools.createOMEXMLMetadata();
metadata.createRoot();
metadata.setImageID(’Image:0’, 0);
metadata.setPixelsID(’Pixels:0’, 0);
metadata.setPixelsBinDataBigEndian(java.lang.Boolean.TRUE, 0, 0);
metadata.setPixelsDimensionOrder(ome.xml.model.enums.DimensionOrder.XYZCT, 0);
metadata.setPixelsType(ome.xml.model.enums.PixelType.UINT8, 0);

imageWidth = ome.xml.model.primitives.PositiveInteger(java.lang.Integer(64))
imageHeight = ome.xml.model.primitives.PositiveInteger(java.lang.Integer(64))
numZSections = ome.xml.model.primitives.PositiveInteger(java.lang.Integer(1))
numChannels = ome.xml.model.primitives.PositiveInteger(java.lang.Integer(2))

3.3. Using Bio-Formats in Matlab 17



Bio-Formats Documentation, Release 4.4.4

numTimepoints = ome.xml.model.primitives.PositiveInteger(java.lang.Integer(2))
samplesPerPixel = ome.xml.model.primitives.PositiveInteger(java.lang.Integer(1))

metadata.setPixelsSizeX(imageWidth, 0);
metadata.setPixelsSizeY(imageHeight, 0);
metadata.setPixelsSizeZ(numZSections, 0);
metadata.setPixelsSizeC(numChannels, 0);
metadata.setPixelsSizeT(numTimepoints, 0);
metadata.setChannelID(’Channel:0:0’, 0, 0);
metadata.setChannelSamplesPerPixel(samplesPerPixel, 0, 0);
metadata.setChannelID(’Channel:0:1’, 0, 1);
metadata.setChannelSamplesPerPixel(samplesPerPixel, 0, 1);

writer.setMetadataRetrieve(metadata);
writer.setId("my-file.ome.tiff");
writer.saveBytes(0, plane); % channel 0, timepoint 0
writer.saveBytes(1, plane); % channel 1, timepoint 0
writer.saveBytes(2, plane); % channel 0, timepoint 1
writer.saveBytes(3, plane); % channel 1, timepoint 1
writer.close();

This example will write a single plane to an OME-TIFF file. It assumes that there are 8 unsigned bits per pixel, and
that the image is 64 pixels x 64 pixels. In your own code, you will need to adjust the dimensions and pixel type
accordingly. Also, ‘plane’ is an array constructed like so:

plane = zeros(1, 64 * 64, ’uint8’);

There is also a script that can save MATLAB arrays to supported formats:

bfsave.m

3.4 Bio-Formats service and dependency infrastructure

3.4.1 Description

The Bio-Formats service infrastructure is an interface driven pattern for dealing with external and internal dependen-
cies. The design goal was mainly to avoid the cumbersome usage of ReflectedUniverse where possible and to
clearly define both service dependency and interface between components. This is generally referred to as dependency
injection, dependency inversion or component based design.

It was decided, at this point, to forgo the usage of potentially more powerful but also more complicated solutions such
as:

• Spring (http://www.springsource.org/)

• Guice (http://code.google.com/p/google-guice/)

• ...

The Wikipedia page for dependency injection contains many other implementations in many languages.

An added benefit is the potential code reuse possibilities as a result of decoupling of dependency and usage in Bio-
Formats readers. Implementations of the initial Bio-Formats services were completed as part of BioFormatsCleanup
and tickets #463 and #464.
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3.4.2 Writing a service

• Interface – The basic form of a service is an interface which inherits from loci.common.services.Service. Here
is the very basic OMENotesService from the initial implementation in r5894:

public interface OMENotesService extends Service {

/**
* Creates a new OME Notes instance.

* @param filename Path to the file to create a Notes instance for.

*/
public void newNotes(String filename);

}

• Implementation – This service then has an implementation, which is usually located in the Bio-Formats com-
ponent or package which imports classes from an external, dynamic or other dependency. Again looking at the
OMENotesService, the implementation is this time in the legacy ome-notes component as OMENotesServi-
ceImpl:

public class OMENotesServiceImpl extends AbstractService
implements OMENotesService {

/**
* Default constructor.

*/
public OMENotesServiceImpl() {

checkClassDependency(Notes.class);
}

/* (non-Javadoc)

* @see loci.formats.dependency.OMENotesService#newNotes()

*/
public void newNotes(String filename) {

new Notes(null, filename);
}

}

• Style

– Extension of AbstractService to enable uniform runtime dependency checking is recommended.
Java does not check class dependencies until classes are first instantiated so if you do not do this, you may
end up with ClassNotFound or the like exceptions being emitted from your service methods. This is
to be strongly discouraged. If a service has unresolvable classes on its CLASSPATH instantiation should
fail, not service method invocation.

– Service methods should not burden the implementer with numerous checked exceptions. Also external
dependency exception instances should not be allowed to directly leak from a service interface. Please
wrap these using a ServiceException.

– By convention both the interface and implementation are expected to be in a package named
loci.*.services. This is not a hard requirement but should be followed where possible.

• Registration – A service’s interface and implementation must finally be registered with the
loci.common.services.ServiceFactory via the services.properties file. Following the OMENotesService
again, here is an example registration:
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...
# OME notes service (implementation in legacy ome-notes component)
loci.common.services.OMENotesService=loci.ome.notes.services.OMENotesServiceImpl
...

3.4.3 Using a service

OMENotesService service = null;
try {

ServiceFactory factory = new ServiceFactory();
service = factory.getInstance(OMENotesService.class);

}
catch (DependencyException de) {

LOGGER.info("", de);
}
...

3.5 Public test data

Most of the data-driven tests would benefit from having a comprehensive set of public sample data (see also #4086).

Formats for which we already have public sample data:

A ‘*’ indicates that we could generate more public data in this format.

• ICS (*)

• Leica LEI

• IPLab

• BMP (*)

• Image-Pro SEQ

• QuickTime (*)

• Bio-Rad PIC

• Image-Pro Workspace

• Fluoview/ABD TIFF (*)

• Perkin Elmer Ultraview

• Gatan DM3

• Zeiss LSM

• Openlab LIFF (*)

• Leica LIF (*)

• TIFF (*)

• Khoros (http://netghost.narod.ru/gff/sample/images/viff/index.htm)

• MNG (Download) (*)

Formats for which we can definitely generate public sample data:

• PNG/APNG
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• JPEG

• PGM

• FITS

• PCX

• GIF

• Openlab Raw

• OME-XML

• OME-TIFF

• AVI

• PICT

• LIM

• PSD

• Targa

• Bio-Rad Gel

• Fake

• ECAT-7 (minctoecat)

• NRRD

• JPEG-2000

• Micromanager

• Text

• DICOM

• MINC (rawtominc)

• NIfTI (dicomnifti)

• Analyze 7.5 (medcon)

• SDT

• FV1000 .oib/.oif

• Zeiss ZVI

• Leica TCS

• Aperio SVS

• Imaris (raw)

Formats for which I need to check whether or not we can generate public sample data:

• IPLab Mac (Ivision)

• Deltavision

• MRC

• Gatan DM2

• Imaris (HDF)
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• EPS

• Alicona AL3D

• Visitech

• InCell

• L2D

• FEI

• NAF

• MRW

• ARF

• LI-FLIM

• Oxford Instruments

• VG-SAM

• Hamamatsu HIS

• WA-TOP

• Seiko

• TopoMetrix

• UBM

• Quesant

• RHK

• Molecular Imaging

• JEOL

• Amira

• Unisoku

• Perkin Elmer Densitometer

• Nikon ND2

• SimplePCI .cxd

• Imaris (TIFF)

• Molecular Devices Gel

• Imacon .fff

• LEO

• JPK

• Nikon NEF

• Nikon TIFF

• Prairie

• Metamorph TIFF/STK/ND

• Improvision TIFF
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• Photoshop TIFF

• FEI TIFF

• SimplePCI TIFF

• Burleigh

• SM-Camera

• SBIG

Formats for which we definitely cannot generate public sample data:

• TillVision

• Olympus CellR/APL

• Slidebook

• Cellomics

• CellWorX

• Olympus ScanR

• BD Pathway

• Opera Flex

• MIAS

The main developer documentation page is here: http://loci.wisc.edu/bio-formats/bio-formats-java-library

Some of the more useful pieces of documentation are:

• Javadocs

• More thorough examples of exporting images and metadata
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CHAPTER

FOUR

GETTING HELP

4.1 Troubleshooting

This page is aimed at anyone who is responsible for supporting Bio-Formats, but may also be useful for advanced
users looking to troubleshoot their own problems. Eventually, it might be best to move some of this to the FAQ or
other documentation.

4.1.1 General tips

• Make sure to read the FAQ, particularly the “File Formats”, “Bio-Formats”, and “OME-XML & OME-TIFF”
sections

• If this page doesn’t help, it is worth quickly checking the following places where questions are commonly asked
and/or bugs are reported:

– OME Trac

– Fiji Bugzilla (for ImageJ/Fiji issues)

– ome-devel mailing list (not searchable)

– ome-users mailing list (not searchable)

– ImageJ mailing list (for ImageJ/Fiji issues)

• Make sure to ask for a _specific_ error message or description of the unexpected behavior, if one is not provided
(“it does not work” is obviously not adequate).

• “My (12, 14, 16)-bit images look all black when I open them” is a common issue. In ImageJ/Fiji, this is almost
always fixable by checking the “Autoscale” option; with the command line tools, the “-autoscale -fast” options
should work. The problem is typically that the pixel values are very, very small relative to the maximum possible
pixel value (4095, 16383, and 65535, respectively), so when displayed the pixels are effectively black.

• If the file is very, very small (4096 bytes) and any exception is generated when reading the file, then make sure
it is not a Mac OS X resource fork. The ‘file’ command should tell you:

$ file /path/to/suspicious-file
suspicious-file: AppleDouble encoded Macintosh file

4.1.2 Tips for ImageJ/Fiji

• The Bio-Formats version being used can be found by selecting “Help > About Plugins > LOCI Plugins”.

• “How do I make the options window go away?” is a common question. There are a few ways to do this:
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– To disable the options window only for files in a specific format, select “Plugins > LOCI > LOCI Plugins
Configuration”, then pick the format from the list and make sure the “Windowless” option is checked.

– To avoid the options window entirely, use the “Plugins > LOCI > Bio-Formats Windowless Importer”
menu item to import files.

– Open files by calling the Bio-Formats importer plugin from a macro.

• A not uncommon cause of problems is that the user has multiple copies of loci_tools.jar in their ImageJ plugins
folder, or has a copy of loci_tools.jar and a copy of bio-formats.jar. It is often difficult to determine for sure
that this is the problem - the only error message that pretty much guarantees it is a “NoSuchMethodException”.
If the user maintains that they downloaded the latest version and whatever error message/odd behavior they are
seeing looks like it was fixed already, then it is worth suggesting that they remove all copies of loci_tools.jar
and download a fresh version.

4.1.3 Tips for command line tools

• When run with no arguments, all of the command line tools will print information on usage.

• When run with the ‘-version’ argument, ‘showinf’ and ‘bfconvert’ will display the version of Bio-Formats that
is being used (version number, build date, and Git commit reference).

4.1.4 Tips by format

3I/Olympus Slidebook (.sld)

• Slidebook support is generally not great, despite a lot of effort. This is the one format for which it is recom-
mended to just export to OME-TIFF from the acquisition software and work with the exported files. Happily,
there is free software from 3I which can do the export post-acquisition: https://www.slidebook.com/reader.php

DICOM

• Health care or institutional regulations often prevent users from sending problematic files, so often we have to
solve the problem blind. In these cases, it is important to get the exact error message, and inform the user that
fixing the problem may be an iterative process (i.e. they might have to try a couple of trunk builds before we
can finally fix the problem).

ZVI

• If the ZVI reader plugin is installed in ImageJ/Fiji, then it will be used instead of Bio-Formats to read ZVI files.
To check if this is the cause of the problem, make sure that the file opens correctly using “Plugins > LOCI >
Bio-Formats Importer”; if that works, then just remove ZVI_Reader.class from the plugins folder.

If you have any questions about installing, using, or developing against Bio-Formats, we would be happy to help - just
send an email to one of the mailing lists and we will do our best answer your questions.

You may also wish to check the OME FAQ and the LOCI FAQ, in case your question is answered there.
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CHAPTER

FIVE

ONLINE RESOURCES

This documentation is a work in progress and many aspects of Bio-Formats are not yet covered. The source code is
hosted on Github. To propose changes and fix errors, go to the Bio-Formats repository, fork it, edit the file contents
under docs/sphinx and propose your file changes to the OME team using Pull Requests.
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